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Chapter 1   About this user guide

This guide contains complete information about how to use DssW Power Manager. This guide has been
designed as a reference document.

This guide assumes you have working knowledge of the Macintosh operating system and its conventions.
For help with the operating system, please see your Mac OS documentation.

Learning about DssW Power Manager
DssW Power Manager includes the following documentation and resources:

DssW Power Manager 2 User Guide
Contains complete instructions about using DssW Power Manager commands and features.

On Screen Help Guide
Contains a how to guide to using DssW Power Manager. It is accessible from the Help menu when DssW
Power Manager is running or through the Mac OS Help Center. This resource is also available online at the
DssW web site.

Scripting Examples
Contains numerous AppleScript examples for DssW Power Manager. The scripts are commented and
demonstrate a range of the possible methods for automating DssW Power Manager.

Mac OS System requirements
To use DssW Power Manager, you need the following hardware and software:

• An Apple Macintosh or 100% compatible computer.
• 8 MB (minimum) of free random access memory (RAM).
• 5 MB of hard disk space.
• Mac OS version 7.6 or later (Mac OS 8.6 or later is recommended).

Available features depend on your hardware’s capabilities.

Installing DssW Power Manager
For instructions on how to install DssW Power Manager, open the installer application and follow the on
screen instructions.

The installer creates a DssW Power Manager folder for the documentation and scripting examples. The
following files are also installed into your computer:

File Destination
Power Manager Control Panels Folder
Power Manager Extension Extensions Folder
Power Manager CSM Control Strips Folder
Power Manager ALM Location Manager Modules
Power Manager Help Help Folder (Mac OS 8.6 and later)

What’s new in DssW Power Manager 2.0
Users of earlier versions of DssW Power Manager will have the benefit of a number of exciting new
enhancements and features as they upgrade to version 2.0. The improvements include:

http://www.dssw.co.uk/


DssW Power Manager 2.0
User Guide

http://www.dssw.co.uk/ 5

New Schedulers
DssW Power Manager 2 contains new Schedulers designed to cater for all your power event requirements.
The new Schedulers are the Once Only and Standard Schedulers.

The Once Only Scheduler provides timing accuracy to the second. This scheduler particularly suits
AppleScripting needs.

Further, all three Schedulers now support wake up and sleep events.

Sophisticated launching functionality
You can now create Actions that occur at predefined times or on specific triggers.

Actions perform tasks such as running AppleScripts, launching applications or opening documents. Using
Actions you can use DssW Power Manager as a hub to control all your automated tasks and work flow
processes. Actions can be refined to perform only when specific conditions are met. Conditions include
specific times, users, months and even if the computer has been idle for a given time.

Enhanced power management options
DssW Power Manager 2 provides greater control over the power management options of your Macintosh.

New options include the ability to automatically shut down the computer instead of sleeping, disabling
sleep while certain applications are open and disabling the keyboard’s power key.

Disabling the power key is great for classroom or kiosk environments.

Powerful administration capabilities
DssW Power Manager 2 offers a suite of features for multiple user environments such as computer
laboratories, offices and public buildings.

Remote configuration
DssW Power Manager can now automatically update the active configuration over a network. Using pull
technology DssW Power Manager can fetch the latest configuration from web, file and AppleShare servers.

Using remote configuration you can configure an entire network of Mac's from your internal or even
Internet based server.

Multiple configurations
Groups of settings can now be manipulated as named configurations. Swap between your configurations
with ease via the control strip, location manager or control panel.

Password Protection
Stop your users from changing your settings with the new Administration mode and password.

Further, DssW Power Manager 2 is multi-user aware and settings are associated with the host computer and
not with individual users. This means DssW Power Manager is suitable for use with Apple’s Macintosh
Manager, Multiple Users (Mac OS 9) and third party multi-user computing software.

http://www.dssw.co.uk/
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Chapter 2   Using the Schedulers

The Schedulers allow you to automatically start up, shut down, wake up and put your computer to sleep.
This chapter shows you how to use the Schedulers.

About the Schedulers
DssW Power Manager includes three Schedulers. Each Scheduler allows you to control if and when your
computer automatically starts up, shuts down, wakes up or enters sleep mode.

The Schedulers can be extended via the AppleScript commands, enqueue and dequeue, within the DssW
Power Manager Extension.

Selecting a Scheduler
Only one of the three Schedulers may be active at any one time.

To select a Scheduler:
1. Switch the Scheduler panel within the control panel.
2. Choose the Scheduler from the pop-up menu.

DssW Power Manager’s Schedulers can be expanded upon via AppleScript. See the enqueue and dequeue
commands in the Power Manager Extension’s dictionary for more information.

If you do not wish to use the Schedulers or prefer to use a third party Scheduler, then switch to the Once
Only Scheduler and disable all the events.

Using the Once Only Scheduler
The Once Only Scheduler provides date and time specific event control. Each event can be scheduled to
occur once at a specific date and time in the future.

Figure 2-1 Once Only Scheduler "Start up on the 10/03/2001 at 4:25:27pm."

The Once Only Scheduler allows events to be scheduled to the second.
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If no events are scheduled in the Once Only Scheduler then DssW Power Manager will not affect the
computer’s wake up or start up timer settings. This is useful in environments where bespoke scheduling
solutions are required.

Scheduling Events
To schedule an event in the Once Only Scheduler:
1. Select the event’s check box.
2. Enter the time into the event’s time control.
3. Enter the date into the event’s date control.

To remove a scheduled event from the Once Only Scheduler:
• Deselect the event’s check box.

Using the Standard Scheduler
The Standard Scheduler allows you to schedule events that occur each week on a specific day of the week.

Figure 2-2 Standard Scheduler "Start up at 9:00am every weekday morning."

Switching Scheduler Mode
Both the Standard and Advanced Schedulers can be switched between start up and shut down event
scheduling to wake up and sleep scheduling.

To switch the Scheduler’s mode:
• Choose the mode from the pop-up menu at the top-right of the Scheduler’s table.

Scheduling Events
To schedule an event in the Standard Scheduler:
1. Select a day of the week by clicking on the day’s row. The editing controls for the selected day will

appear at the base of the table. The editing controls will remain visible while a day of the week is
selected.

2. Select the event’s check box.
3. Enter the time into the events time control.
4. Click the ‘Apply’ button to confirm the change.

To remove a scheduled event from the Standard Scheduler:
1. Select a day of the week by clicking on the day’s row.
2. Deselect the event’s check box.

http://www.dssw.co.uk/
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3. Click the ‘Apply’ button to confirm the change.

Using the Advanced Scheduler
The Advanced Scheduler extends the capabilities of the Standard Scheduler by providing the ability to
schedule multiple events per day of the week.

The Advanced Scheduler supports start up/shut down and wake up/sleep modes. To change the scheduler’s
mode see “Switching Scheduler Mode” on page 7.

The Advanced Scheduler’s panel is divided into two tables: the Day/Event Table and the Day/Hour Table.

Figure 2-3 Advanced Scheduler "Start up at 7.00am on Mondays, shut down at 6.00pm on Wednesdays. On Fridays start up at 7.00am
and 1.00pm and shut down at midday and 6.00pm"

The Day/Event Table
The Day/Event Table is a two by seven grid on the left-hand side of the panel.

Each day of the week has two entries. Each entry represents an event. If the event is selected then the event
can be scheduled on the given day of the week. If the event is not selected, then the event will not be
scheduled.

Using this table you can set up a day in which the computer starts up on multiple occasions but never
schedules an automatic shut down.

The Day/Hour Table
The Day/Hour table is a twenty-four by seven grid on the right of the panel.

Each entry represents a single hour on the row’s day of the week. The top-left entry of the table represents
Monday between midnight and one o’clock in the morning. The bottom-right entry represents Sunday
between eleven o’clock and midnight.

How the Advanced Scheduler works
The Advanced Scheduler works by looking for changes in sequential entries of the Day/Hour Table.

To the scheduler the day/hour table is a single closed loop of entries. Each row is joined to the next and
previous rows.
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Figure 2-4 Advanced Scheduler "Switch on at 7.00am on Mondays."

In the example above, when the scheduler examines Monday, it will find the change between the sixth and
seventh entries. The change is transition between the Off and On state. This means the computer needs to
be started up at 6.00 a.m., if it is not already running.

Having found the change between the sixth and seventh entries, the scheduler will next notice the change in
state between the seventh and eight entries. This transition is between the On and Off state, representing a
shut down. This change is not acted upon because shut down events are not enabled in the Day/Event
Table.

http://www.dssw.co.uk/
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Chapter 3   Using the Launcher

DssW Power Manager includes a tool that enables applications, scripts and documents to be launched, run
or opened at specific times and on specific triggers. This tool is called the Launcher. This chapter
demonstrates some of the capabilities of the Launcher and shows you how to use it.

About the Launcher
The Launcher enables you to build sophisticated actions without requiring any programming skills. You
can devise complex Actions without typing or seeing a single line of code.

In DssW Power Manager you can work with the Launcher and Actions in two ways:

• You can use DssW Power Manager’s control panel to create actions via the point and click interface.
• You can also use AppleScript to manipulate actions within the Launcher.

Working with Actions
The Launcher consists of a list of Actions. Actions allow you to run scripts, launch applications and open
documents at specific times and dates or on a given event.

Actions are built up of three components. These components are:

• Trigger
• Conditions and Modifiers
• Tasks

Trigger
The Trigger informs Power Manager when to start the Action.

Triggers range from specific times and dates to events such as a user logging in. Power Manager supports a
wide range of triggers.

Conditions and Modifiers
The Conditions and Modifiers provide sophisticated control over the Action.

Once an Action is triggered Power Manager checks that all the conditions are met. If a single condition is
not met, then the Action's Tasks will not be performed.

Conditions control whether the Action's Tasks are to be performed or not. By combining conditions you
can gain exact control over the Action. As an example, by using the Specific Day and Specific Month
conditions, you could limit an Action to particular days in the week and then only in certain months of the
year.

Modifiers directly affect the Action. A modifier such as the Retrigger Modifier provides the ability to set
up looping Actions or Actions that are triggered at regular intervals.

Modifiers do not affect the Action’s settings until after the Action has been triggered.

Tasks
Tasks represent events that the Action should perform if the conditions are met.

http://www.dssw.co.uk/
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Tasks include:

• Running scripts
• Launching applications
• Opening documents

An Action can contain numerous tasks, each is performed in order and only once when the trigger occurs
and the conditions are met.

To Activate the Launcher
The Launcher is located within the DssW Power Manager control panel. To use the Launcher, it must be
active.

1. Select the Launcher tab from the list at the top of the control panel.
2. Click the Launcher check box to activate the Launcher.

Figure 3-1 Select the check box to activate the Launcher

Creating an Action
The Launcher contains a list of Actions. The Actions are listed in the Launcher panel’s Actions’ list,
located in the centre of the panel.

• Click the ‘Add’ button below the Actions’ list area of the Launcher panel to create a new Action and
open a corresponding Action Editor window.

To learn about editing your new Action, see “Editing an Action” on page 11.

Editing an Action
To edit an Action, you need to create a new Action or select an existing Action from the Launcher’s
Action’s list. See “Creating an Action” on page 11.

1. Select an Action in the Launcher’s Actions’ list. When an Action is selected, the Action’s row is
highlighted and the Edit and Remove buttons at the base of the list are enabled.

2. Click the Edit button at the base of the Launcher panel to open an Action Editor window.

The Action Editor window consists of four sections. The Action Editor lets you control every aspect of an
Action and its properties.

http://www.dssw.co.uk/
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A

B

Figure 3-2 Action Editor window
A. Action name text field
B. Trigger panel
C. Conditions and Modifiers panel
D. Tasks panel

Editing an Action’s name
1. In the Action name text field type in a name for the Action.
2. Press Enter or click the OK button to confirm the change and close the Action Editor window.

The name and trigger of the Action are the only visible attributes displayed in the Launcher’s Actions’ list.
Choosing verbose and descriptive names will benefit your use of the Launcher.

When scripting the Launcher with AppleScript, note that individual Actions are normally referenced by
name. To avoid confusion in environments where AppleScript and manual Launcher management occurs,
ensure your Actions have unique names.

Editing an Action’s Trigger
Each Action has an associated Trigger. The Trigger denotes an event, on which the Action should be
initiated. An Action may only have one Trigger. To learn more about setting up repeating triggers, see
“Retrigger” on page 16.

Select the Action’s Trigger from the pop-up menu in the Trigger panel of the Action Editor window.

Figure 3-3 Select the Trigger from the pop-up menu
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The Triggers
DssW Power Manager includes a range of Triggers for you to choose including: wake, system sleep, start
up, shut down, date/time, daily, weekly, monthly, user log in and user log out.

Several of the Triggers have properties. Where applicable these properties are displayed in the Trigger
panel.

Start Up
Start up triggers the Action after the computer has been switched on and the System has finished loading.
This Trigger can be used as a sophisticated alternative to the ‘Start Up Items’ folder.

Shut Down
Shut down triggers the Action before the computer shuts down. This Trigger can be used as a sophisticated
alternative to the ‘Shut Down Items’ folder.

Keep these points in mind:
• Try to keep the tasks processing time as short as possible.
• Launching applets causes the shut down to be cancelled. To continue the shut down, call the shut down

command once the applet has completed its processing.

Wake
Wake triggers the Action after the computer has restored itself from a low power state or sleep mode.

Date and Time
Date and Time triggers the Action when the specified date and time occurs.

Figure 3-4 Date and Time Trigger “Trigger the Action at 9.05 a.m. on 25th December 2001.”

Daily
Daily triggers the Action once each day when the specified time occurs.

Figure 3-5 Daily Trigger “Trigger the Action every day at 9.05 a.m.”

Weekly
Weekly triggers the Action once each week when the specified day and time occurs.

Figure 3-6 Weekly Trigger “Trigger the Action every Tuesday at 9.05 a.m.”

Monthly
Monthly triggers the Action once each month when the specified day and time occurs. The day can be
specified in a range of formats including:

• Absolute dates i.e. 3rd of the month
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• By day of the week i.e. first Tuesday of the month
• On notable days i.e. last day of the month

Figure 3-7 Monthly Trigger “Trigger the Action on the penultimate day of every month at 9.05 a.m.”

Log in
Log in triggers the Action when a user logs in to the computer.

Note At this time the operating system may not yet have loaded the resources required to process some
scripts.

Log out
Log out triggers the Action when a user logs out of the computer.

Editing an Action’s Conditions and Modifiers
The Conditions and Modifiers panel provides absolute control over when the Actions are performed. Using
combinations of Conditions enables you to precisely control your Actions and limit their effects to desired
situations. For example, using a Required Idle Time Condition can ensure that the computer is not being
used when starting your back up or diagnostic software. See “Required Idle Time” on page 16.

The applicable Conditions and Modifiers for the current Trigger are listed in the panel entitled Conditions
and Modifiers.

A

B

D

C

Figure 3-8 Conditions and Modifiers panel

A. A collapsed and enabled Condition
B. An enabled and expanded Condition
C. Click here to toggle the Condition’s state
D. Click here to expand or contract the Condition’s options

The Conditions and Modifiers panel intelligently adapts the available options with regard to the Action’s
Trigger. As an example, the Required Idle Time Condition is not available when the Trigger is Start Up.
See “Start Up” on page 13 and “Required Idle Time” on page 16.

Once you have finished setting a Condition or Modifier’s options, you can hide the options by clicking on
the disclosure arrow. This allows you to focus on one set of options at a time. See Figure 3-8 above.

The Conditions
DssW Power Manager provides an extensive range of Conditions to apply to your Actions.

Start Date/Time
The Start Date/Time Condition limits the date from which the Action can begin the Tasks.

http://www.dssw.co.uk/


DssW Power Manager 2.0
User Guide

http://www.dssw.co.uk/ 15

Figure 3-9 Start Date/Time Condition “Permit the Tasks only if the current date is or after 9.05 a.m. on 25th December 2001.”

End Date/Time
The End Date/Time Condition limits the period in which the Action can begin the Tasks.

Figure 3-10 End Date/Time Condition “Permit the Tasks only if the current date is or before 9.05 a.m. on 25th December 2001.”

Specific Days
The Specific Days Condition limits the days of the week in which the Action can begin the Tasks.

Figure 3-11 Specific Days Condition “Permit the Tasks only if the current day of the week is Saturday or Sunday.”

Specific Months
The Specific Months Condition limits the months in which the Action can begin the Tasks.

Figure 3-12 Specific Months Condition “Permit the Tasks only if the current month is December.”

Specific Time Period
The Specific Time Period Condition limits the time period in which the Action can begin the Tasks.

Figure 3-13 Specific Time Period Condition “Permit the Tasks only if the current time is greater than or equal to 9.05 a.m. and less
than or equal to 9.50 p.m.”

Specific User
The Specific User Condition limits the Action dependent on the currently logged in user.
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Figure 3-14 Specific User Condition “Permit the Tasks only if the current user is Graham Miln.”

Note: The user names of administrators are not available under some multiple user software. Check the log file to ensure that user
names are correctly passed to DssW Power Manager.

Required Idle Time
The Specific Idle Time Condition only permits the Tasks after a given period of idle time has passed.

Figure 3-15 Required Idle Time Condition “Permit the Tasks only if the computer has been idle for at least 15 minutes.”

Frequency
The Frequency Condition ensures that the tasks are not performed too often. Using this condition you can
ensure that the tasks are only performed once per given time period. A notable use of this condition is to
combine it with an hourly Retrigger Modifier. As an example, if the Action’s Trigger is set to Start Up, the
Retrigger Modifier is set to Continuously and the Frequency Condition is set to Daily, then the Action’s
tasks will be performed once per day.

Figure 3-16 Frequency Condition "Permit the Tasks only if they have not be performed in the last day."

The Modifiers
Modifiers allow you take greater control over the lifetime of an Action, and can greatly enhance the
number of situations in which an Action can occur.

Modifiers apply their modifications regardless of whether the Conditions were successfully met.

Retrigger
The Retrigger Modifier lets you retrigger an Action repeatedly, for a given period, after the Action’s main
Trigger has occurred. See “Editing an Action’s Trigger” on page 12.

The Retrigger Modifier provides properties for controlling the interval between repeat triggers, and the
period in which the Modifier remains active.

Figure 3-17 Select the retrigger period from the pop-up menu

Only one instance of an Action is active at any one time. Once the Retrigger Modifier is activated, then the
original Action’s Trigger is temporarily disabled. After the Retrigger has finished, the original Trigger is
enabled.

Shutting down or restarting the computer annuls all active Retrigger Modifiers.
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Continuously

The default Retrigger Modifier will continue to trigger the Action until the computer is shut down or
restarted.

Figure 3-18 Retrigger Modifier “Trigger the Action every 10 minutes until shut down or restart.”

Duration

A duration based Retrigger Modifier will continue to trigger the Action for a specified number of minutes,
or until the computer is shut down or restarted.

Figure 3-19 Duration based Retrigger Modifier “Trigger the Action every 10 minutes for 40 minutes, or until shut down or restart.”

Time

A time based Retrigger Modifier will continue to trigger the Action until a specified time is reached, or
until the computer is shut down or restarted.

Figure 3-20 Time based Retrigger Modifier “Trigger the Action every 10 minutes until 9.50 p.m., or until shut down or restart.”

Counter

A counter based Retrigger Modifier will trigger the Action a specified number of times or until the
computer is shut down or restarted.

Figure 3-21 Counter based Retrigger Modifier “Trigger the Action every 10 minutes, 15 times.”

Editing an Action’s Task
Each Action contains a list of tasks to perform when the trigger is tripped and the conditions are met. The
tasks can include launching applications, opening documents and running scripts.

The Tasks
DssW Power Manager supports three varieties of tasks. When you add a new task, DssW Power Manager
automatically chooses the task’s type for you.

To add a task to an Action:

• Click the plus (+) button at the top-right of the tasks panel.

Figure 3-22 Add/Remove Action Task buttons
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Select a file using the file selection dialog.

Note: New tasks can be added by dragging files from the Finder or Desktop onto the tasks panel.

To remove a task from an Action:

1. Select the task to remove by clicking on it.
2. Click the minus (-) button at the top-right of the tasks panel.

Note: The selected task can also be removed by dragging it to the Trash or by typing ‘Command’ +
‘Delete’.

To change the order in which the tasks are performed:

• Click and drag the tasks to reorder them.

To duplicate a task:

1. Select a task by clicking on it.
2. Drag the task with the Option key held down.

Launching Applications
Applications added to an Action’s tasks will be launched when the tasks are being performed. Launching
an application is equivalent to double-clicking an application’s icon in the Finder or Desktop.

Applications include AppleScript applets, control panels and utilities.

Figure 3-23 Launch Task "Launch the application Setup Assistant."

Running Scripts
Scripts added to an Action’s tasks will be run when the tasks are being performed. Scripts are the preferred
task for shut down, log in and log out triggers.

Script based runtime errors are logged in the DssW Power Manager log file. If an error occurs, then the
script is stopped without affecting the remaining tasks.

Keep in mind that scripts are run within the memory partition of DssW Power Manager and therefore care
should be taken when running large or memory intensive routines.

To open a script instead of running it:
1. Create an alias of the script.
2. Add the alias to the Action’s tasks.

Figure 3-24 Run Task "Set Sound Volume to 1."

Opening Documents
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Documents added to a task will be opened when the tasks are being performed.

Many applications can start processing a file without user interaction when it is opened via a document. For
example, opening a multimedia document such as a music file or presentation often results in the associated
application playing the music or starting the presentation without user interaction.

Figure 3-25 Open Task "Open Barber-Angus Dei.mp3."
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Chapter 4   Using the power management
facilities

DssW Power Manager’s power management facilities provide absolute control over the energy saving
capabilities of the Macintosh.

The power management facilities are divided into related groups. Each panel within the DssW Power
Manager control panel represents a group. This chapter discusses the options presented by each panel and
explains how to use them to best advantage.

Idle Time Settings
The Idle Time Settings panel provides you with the controls needed to customise your computer's sleep
timers.

Figure 4-1 Idle time settings panel

Modern computers are capable of entering lower power usage modes. These modes ensure that while a
computer is not in use, it requires the minimum quantity of power possible. This mode is referred to as
sleep mode.

By entering various degrees of sleep mode, your computer saves electricity and thus reduces running costs.
The computer enters sleep mode when it is not in use.

Your computer uses a measurement of idle time to decide when to trigger its sleep modes.

Idle time is a measurement of time since you last used your computer.

To activate the idle time settings enable the check box at the top-left of the panel. If the check box is not
enabled, then the computer will not enter sleep mode unless you directly request it to.

To resume working after the computer has entered sleep mode, press a key on the keyboard or move the
mouse. After a few seconds the computer will return to full power.
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System Sleep
The System Sleep slider specifies the number of idle minutes before the entire computer enters sleep mode.

Peripheral devices attached to your computer may also sleep at this time. This includes your display, hard
drive and other energy saver aware devices.

If you do not want the System to sleep, move the slider to the right hand side of the scale. The slider’s state
should now read 'Never'.

Automatic shut down instead of System sleep
If you want your computer to shut down instead of entering low power mode, enable this check box. This
option only affects idle time triggered System sleep.

Display Sleep
The Display Sleep slider specifies the number of idle minutes before the display enters sleep mode. When
the display sleeps it will either black out or turn off completely.

The slider's range will vary depending on the System slider's current value. The Display Sleep idle time is
always lower than or equal to the System Sleep idle time.

Hard Drive Sleep
The Hard Drive Sleep slider specifies the number of idle minutes before the hard drive sleeps. When a hard
drive sleeps it spins down the physical storage disk within its casing.

Never spin down hard drive
To stop the hard drive from sleeping/spinning down, enable this check box. This option is particularly
suited to servers and environments where hard drive access needs to be quick. Spinning up a hard drive can
take 5 seconds or more and thus this limits the recovery speed of a computer waking from sleep.

Notification
The Notification panel provides control over automatic shut downs.

Figure 4-2 Notification settings panel
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How automatic shut down events work

An automatic shut down occurs when a scheduler requests a shut down. Unlike a standard shut down, an
automatic shut down provides you will a number of options to control how the computer shuts down.

An automatic shut down generally performs the following sequence of events:

15 minutes before the automatic shut down a notification is presented to the user. This notification warns
the user of the pending shut down event. At this stage the user may be able to cancel or delay the shut
down.

When the automatic shut down is due, DssW Power Manager checks to see if the computer has been idle
for at least 5 minutes.

If the computer has been idle for the required time, then the computer is informed to shut down.

If the computer has not been idle for long enough, because the user is still active, then the pending shut
down is delayed by 5 minutes. At this time a notification is presented to warn the user that the computer
will shut down after 5 minutes of idle time.

Nearly every aspect of this process can be amended to suit your needs.

Note: The period of required idle time needed before the shut down can be edited via AppleScript. The
ability to force the computer to shut down without any required idle time is also supported. These features
should be used with care and are thus only accessible via AppleScript.

Unless you have specific reasons not to warn the user, we highly recommend that you present some
notification to the user.

Notification Period
This slider controls the number of minutes before an automatic shut down that the notification should be
presented.

If an automatic shut down is queued within the notification period, then the notification will be presented
immediately.

Notification Options
The form that the notification takes is defined through the remaining options of this panel. The options can
be combined in any manner you desire.

Displaying a dialog

Enabling this check box will notify the user of the pending shut down by displaying a dialog box.

The dialog box can contain your own message to the user i.e. 'Remember to lock up the lab before leaving'
or 'Please save your work and log out now'.

When the notification occurs the user can be granted the permission to delay or cancel the pending
automatic shut down.
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Figure 4-3 Notification message and permissions dialog

The permissions granted here affect AppleScripts. You can for example enable the permissions to cancel
and delay but disable the ‘Display a dialog’ check box. This configuration combined with an Applet
launched by the Open Application option can be used to present a custom dialog box of your own. An
example of a replacement dialog is included in the DssW Power Manager scripting examples.

Playing a sound

Enabling this check box will notify the user of the pending shut down by playing a sound of your choice.

Displaying a blinking icon

Enabling this check box will notify the user of the pending shut down by placing a flashing icon in the
menu bar.

Opening an application

Enabling this check box provides you with the ability to launch an application when the notification is
presented.

A sample notification dialog
The sample dialog below contains a custom message and allows the user to delay or cancel the pending
shut down. The notification provides the user with an opportunity to:

• Save their work
• Delay the pending shut down
• Cancel the pending shut down

The dialog will remain on the screen for one minute before automatically dismissing itself.

Figure 4-4 Automatic shut down warning
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Sleep Options
The Sleep Options panel provides you with the controls needed to customise the sleep and corresponding
wake up events.

Figure 4-5 Sleep/wake options panel

Wake Options
These options affect the wake up event. This event occurs when the computer changes from sleep mode
(low power state) to full power mode.

Waking up when the phone rings
To wake up the computer when the phone rings, enable this check box.

The computer must have an internal modem that can detect an incoming call to use this feature.

Waking up for network users
Network wake enables a remote computer to wake up the computer via the network. Using this pop-up
menu you can define who has permission to wake this machine from sleep. Alternatively you can disable
this feature by setting the option to 'disabled'.

Playing a sound on wake up
If you want your computer to play a sound when it wakes up, then enable this check box and select a
corresponding sound from the pop-up menu.

Sleep Options
The Display Sleep slider specifies the number of idle minutes before the display enters sleep mode. When
the display sleeps it will either black out or turn off completely.

Muting the volume while asleep
When enabled this option will mute the computer's volume while it is asleep.

Unmounting servers before sleep
Entering sleep mode may cause network connections to be severed. This option enables the computer to
disconnect from AppleShare servers before sleeping.
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Prohibiting sleep mode
Use this option to prohibit the computer from entering idle triggered sleep mode while specific applications
are running.

This feature is particularly useful for applications such as:

• Multimedia, CD or MP3 players
• First aid utilities
• e-Books or applications where the user may be reading from screen for extended periods

Miscellaneous
The Miscellaneous panel contains an assortment of discrete features.

Figure 4-6 Miscellaneous settings panel

Disabling the power key
The power key is a key generally found at the top-right of the keyboard. It is marked with a triangle.

Pressing this key when the computer is running causes a dialog box containing the options to sleep, restart
or shut down to appear.

In some situations, such as classrooms, labs or in kiosks, this functionality can be detrimental. Enable this
check box to disable this dialog box.

Automatic restart after power failure
Enable this check box to automatically restart the computer after a power cut. The computer will only
restart if it was on at the time of the power cut or it should have started up automatically during the power
cut.

Enabling processor cycling
Some computer processors are capable of switching between multiple operating speeds. When the
computer is inactive or idle the processor can switch to a lower operating speed to reduce power
consumption. Enable this check box to allow processor cycling.
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SCSI disk mode ID
Portable computers can often be connected to desktop computers as external hard drives. The connection,
where possible, is made through the SCSI chain. Each SCSI device on a single chain must have a unique ID
number. This option enables you to control the SCSI ID of the computer when attached to another
computer as an external hard drive.
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Chapter 5   Advanced Features

User Modes
Power Manager supports user modes. User modes enable an administrator to lock down and prevent
settings from being changed.

User modes are most effective, in multiple user environments where numerous users would normally be
able to amend DssW Power Manager’s settings.

Figure 5-1 User Mode Dialog

Standard User
Standard user mode provides complete access to all of DssW Power Manager’s settings.

Standard user mode is best suited to single user computers.

Administration User
Administration mode provides complete access to all of DssW Power Manager’s settings.

In this mode you can optionally set up a password to prevent unauthorised users from changing your
settings. To set up the password click on the 'Set Password' button from the User Mode dialog, see Figure
5-1 above.

Please note that your password can not be retrieved if you lose it!

When DssW Power Manager is locked, a user without the password may:

• Select the Active Configuration
• Export Configurations

Locking your settings
To lock all of your settings, click on the unlocked pad lock icon at the bottom-right of the current panel or
dialog box.

Unlocking your settings
To unlock all of your settings, click on the locked pad lock icon at the bottom-right of the current panel or
dialog box.

If a password has been previously set, then you will be asked to enter it at this time.
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Using Configurations
Power Manager supports multiple configurations. Configurations enable you to switch between different
groups of settings with ease.

A configuration is a named set of Power Manager options. A configuration can be used to store groups of
options suited to specific times and places. A configuration named 'Term Time' could store your settings
for the term time, in which the schedulers power up the machine each morning. A corresponding
configuration called 'Holidays' could store settings required to automate the computers during the holiday
period.

The current configuration is called the Active Configuration. Only one configuration may be active at any
one time.

You can switch Active Configurations via the ‘File > Configurations...’ menu item in the control panel, the
Control Strip and through the Location Manager.

Selecting the Active Configuration
DssW Power Manager’s Active Configuration can be selected through a range of interfaces. These
interfaces include the control panel, the Control Strip Module and the Location Manager Module.

To change the Active Configuration from the control panel:

1. Open the configurations dialog through the menu item ‘File > Configurations…’
2. Select the configuration you wish to activate.
3. Click the ‘Make Active’ button.

Using the Control Strip
You can also view and select the Active Configuration through the DssW Power Manager control strip
module.

Figure 5-2 Control Strip Module

Using the Location Manager
DssW Power Manager fully supports the Location Manager. Configurations can be imported and exported
using the Location Manager. For more information about using the Location Manager, see your Mac OS
documentation.
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Figure 5-3 Location Manager Module

Manipulating Configurations
The configurations dialog allows you to manipulate configurations as named objects. You can access the
configurations dialog via the menu item ‘File > Configurations…’.

Figure 5-4 Configurations Dialog

Adding a new configuration
1. To add a new configuration:
2. Open the configurations dialog.
3. Click on the ‘Add’ button.
4. Enter a unique name for the new configuration.
5. Click ‘OK’ to create the new configuration.
6. Click ‘Done’ or ‘Make Active’ to finalise the new configuration.

Duplicating a configuration
1. To duplicate an existing configuration:
2. Open the configurations dialog.
3. Select a configuration.
4. Click on the ‘Duplicate’ button.
5. Enter a unique name for the duplicate configuration.
6. Click ‘OK’ to duplicate the selected configuration.
7. Click ‘Done’ or ‘Make Active’ to finalise the duplicated configuration.

Removing a configuration
1. To remove a configuration:
2. Open the configurations dialog.
3. Select the configuration to remove.
4. Click the ‘Delete’ button.
5. Click ‘OK’ to confirm the removal of the selected configuration.
6. Click ‘Done’ or ‘Make Active’ to finalise the removal.

Note: The Active Configuration can not be deleted.

Importing configurations
DssW Power Manager configurations can be imported from files on a local storage device, such as a
removal drive or hard drive. We recommend that you postfix the configuration’s file name with '.pmc'.
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1. To import a local configuration:
2. Open the configurations dialog.
3. Click the ‘Import’ button.
4. Select the configuration file to import.
5. Enter a unique name for the imported configuration.
6. Click ‘Done’ or ‘Make Active’ to finalise the import.

Configurations can also be imported over a network or the Internet.

1. To import a remote configuration:
2. Open the configurations dialog.
3. Click the ‘Import URL’ button.
4. Enter the URL of the configuration to import.
5. Enter a unique name for the imported configuration.
6. Click ‘Done’ or ‘Make Active’ to finalise the import.

Exporting configurations
Exporting configurations is a great way of backing up your DssW Power Manager settings. Exported
configurations are saved one configuration to a file in an Internet safe format. You may freely e-mail to or
store configuration files on non-Macintosh operating systems without damaging their contents.

Exported configuration files can be used to serve DssW Power Manager installed computers with remote
configurations, see “Remote Configuration” on page 30.

To export a configuration:
1. Open the configurations dialog.
2. Select the configuration to export.
3. Click the ‘Export’ button.
4. Select a destination for the configuration file.

Remote Configuration
DssW Power Manager supports pull based remote configuration.

Remote configuration enables a computer with DssW Power Manager installed to automatically
synchronise the Active Configuration with a configuration store on a server.

The server can be any generic server supported by Apple's URL Access technology. Supported servers
include HTTP, HTTPS, FTP, AppleShare and local file servers.

Figure 5-5 Remote Configuration Dialog
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Setting up the server
To prepare a server to host DssW Power Manager configurations:
1. Within the DssW Power Manager control panel, set up a configuration with the settings you wish to

publish.
2. Export the configuration to a file, see “Exporting configurations” on page 30.
3. Place the newly exported file onto your server so that it may be read by client computers. For

instructions regarding specific servers, see the server's documentation.

The client will only update the Active Configuration if the configuration on the server has changed since
the last synchronization.

Setting up the client
To set up remote configuration on a Macintosh with DssW Power Manager installed:

1. Within the DssW Power Manager control panel, switch to Administration user mode, see
“Administration User” on page 27. Set up a password to prevent unauthorised users from altering the
settings, see “Locking your settings” on page 27.

2. Delete all but the Active Configuration. This prevents the user from switching configurations.
3. Open the Remote Configuration dialog. ('File > Remote Configuration...')
4. Enter your remote configuration details.
5. Click 'OK' to close the dialog and accept the settings.
6. Click the lock to prevent further changes to your settings.

Congratulations, the client is now set up to accept remote configurations!

AppleScript
DssW Power Manager fully supports Apple’s scripting technology AppleScript. Included in the DssW
Power Manager installation are numerous commented AppleScripts for you to learn from.

For more information about AppleScripting with DssW Power Manager, visit the DssW web site at
http://www.dssw.co.uk.

For more information about AppleScript, see the AppleScript documentation provided with the Mac OS.
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